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Package Contents

Contents of Package:

m D-Link DP-G321 Wireless Multi-port Print Server
B Manual and Warranty on CD
m Printed Quick Installation Guide

If any of the above items are missing, please contact your reseller.

System Requirements:

B A computer with an installed Ethernet adapter for initial
configuration purposes only

B Windows XP/2000/Me/98SE, Mac OS with AppleTalk , or
Linux

m A computer or a network of computers with wireless
capability

B Internet Explorer 6.0, or Netscape Navigator version 6.0 or
above, with JavaScript enabled

m The printer must support the required Operating System




Introduction

The D-Link DP-G321 Print Server is an 802.11g wireless Multi-Port Print Server that
allows you to connect your USB printer or parallel printer directly to your network.
Now you can locate printer services virtually anywhere in your home or office. The
DP-G321 manages the flow of print files from workstations or file servers to
connected printers, delivering print jobs to printers much faster than a file server on
a PC.

The DP-G321 includes easy-to-use software to install on most Windows-based
networks. Protocol support for TCP/IP, NetBEUI, and AppleTalk are provided to
ensure seamless connection to major networking operating systems.

The DP-G321 has a built in Web-based management feature that allows users to
easily configure and manage print queues through TCP/IP.

The DP-G321 provides a 10/100Mbps auto-sensing Ethernet port, allowing flexible
attachment to either 10BaseT or 100BaseTX networks. With two USB 2.0 ports
and one standard parallel port, the DP-G321 is an ideal wireless high-speed Print
Server for a home or office that has multiple printers.

The DP-G321 improves network printing services in the following ways:

B The DP-G321 delegates print jobs to the network printer. This provides
workload relief to your file servers and allows the file servers’ full capacity
to be used for file access or other direct services to network users. On
peer-to-peer networks, workstations can print directly to the Print Server
without increasing the load of another workstation or server.

B The DP-G321’s USB 2.0 ports can transmit data to high-speed laser
printers much faster than a PC’s parallel printer port. With a separate
parallel port, you will still have the option to use a standard parallel printer
with the DP-G321.

B Because the DP-G321 is very portable and inexpensive compared to a
PC-based print server, and the Print Server connects to your file servers
through the network, printers can be deployed to locations of maximum
convenience to users.



The DP-G321 offers extraordinary flexibility, operating with all major network
operating systems and protocols:

L TCP/IP
UNIXlpr/pd
Windows NT/2000, Windows 95/98SE/Me, Windows XP
NetWare 5.x NDPS LPR Remote Printing

m NetBEUI
Windows 2000/XP, Windows 95/98SE/Me, Microsoft LAN
Manager, IBM LAN Server

m AppleTalk
MacOS EtherTalk

Windows-based setup and administration software, PS Admin, is supplied with
the Print Server, making configuration and management quick and easy. The
Print Server also supports configuration and management via the Telnet protocol
for networks without Windows-compatible systems.

External Features

Port Connectors

The DP-G321’s two USB ports and parallel port are located on its rear panel. The
printer port can be configured using the PS Admin program or the print server’s
Telnet interface. (See the PS Admin User’s Guide, available on the CD that came
with the DP-G321, for information about configuring the print server’s ports.) The
Print Server also supports web configuration permitting users to configure settings
through the web browser. The default IP Address is as follows:

| Default IP Address —192.168.0.10

[ | Subnet Mask —255.255.255.0

Note:

The PC’s IP Address must be in the same subnet as the Print Server’s IP Address for the
two devices to communicate. (For example, if your Print Server’'s IP Address is
192.168.0.10, with a subnet mask of 255.255.255.0, then your computer’s |IP Address
should be 192.168.0.x, where x is a value between 1-254, excluding 10.)




Front Panel LED Indicators

There are two front panel indicators, each holding two separate LEDs (aligned in a
vertical position). As shown below, the first indicator holds the Power and the USB
LED. The second indicator holds the Ethernet and WLAN LED. Upon boot-up, the
Power light stays on continuously and all other LEDs light up momentarily one-by-
one, then turn off.

Power
A steadily lit LED indicates proper operation of the Print Server.

Link/Activity

A steadily lit LED indicates proper network connection; no lit LED indicates
an unsuccessful network connection. A blinking LED indicates activity
(configuration or printing).

WLAN

A steadily lit LED indicates a proper wireless network connection; no lit LED
indicates an unsuccessful wireless network connection. A blinking LED
indicates activity (configuration or printing).

usB1

A steadily lit LED indicates that the Print Server is transferring print data to
the USB1 printer port.

USB2
A steadily lit LED indicates that the Print Server is transferring print data to

the USB2 printer port.
LPT

A steadily lit LED indicates that the Print Server is transferring print data to
the parallel printer port.

Power WLAN usSB2

Link/Act usSB1 LPT

il Al wWLAN usat ussz T DP-G321




Rear Panel Connectors

Network Cable Connector

The Print Server’s rear panel has a LAN port for CAT5 Ethernet
cabling. The port supports the NWay protocol, allowing the Print
Server to automatically detect or negotiate the transmission
speed of the network.

DC Power Connector

The DC power input connector is located on the Print Server’s
rear panel and is labeled DC 5V.

Antenna

LPT UsB1 Reset




Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use
and compatible high-speed wireless connectivity within your home, business or
public access wireless networks. D-Link wireless products will allow you access to
the data you want, when and where you want it. You will be able to enjoy the
freedom that wireless networking brings.

A wireless LAN (WLAN) is a cellular computer network that transmits and receives
data with radio signals instead of wires. WLANS are used increasingly in both home
and office environments, and public areas such as airports, coffee shops, and
universities. Innovative ways to utilize WLAN technology are helping people to work
and communicate more efficiently. Increased mobility and the absence of cabling
and other fixed infrastructure have proven to be beneficial for many users.

Wireless users can use the same applications they use on a wired network.
Wireless adapter cards used on laptop and desktop systems support the same
protocols as Ethernet adapter cards.

People use wireless LAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location
within the operating range of the WLAN. Management decisions based on real-
time information can significantly improve worker efficiency.

Low Implementation Costs — WLANS are easy to set up, manage, change, and
relocate. Networks that frequently change can benefit from WLANs ease of
implementation. WLANs can operate in locations where installation of wiring may
be impractical.

Installation and Network Expansion - Installing a WLAN system can be fast and
easy and can eliminate the need to pull cable through walls and ceilings. Wireless
technology allows the network to go where wires cannot go - even outside the
home or office.

Scalability — WLANs can be configured in a variety of topologies to meet the
needs of specific applications and installations. Configurations are easily changed
and range from peer-to-peer networks suitable for a small number of users to
larger infrastructure networks to accommodate hundreds or thousands of users,
depending on the number of wireless devices deployed.

Inexpensive Solution - Wireless network devices are as competitively priced as
conventional Ethernet network devices.



Wireless Basics (cont.)

Standards-Based Technology

Based on the IEEE 802.11g standard, the DP-G321 is interoperable with existing
compatible 2.4GHz wireless technology with data transfer speeds of up to 54Mbps
when used with other D-Link AirPlus G devices.

Installation Considerations

The D-Link AirPlus G DP-G321 lets you print through your network, using a
wireless connection, from virtually anywhere within its operating range. Keep in
mind, however, that the number, thickness and location of walls, ceilings, or other
objects that the wireless signals must pass through, may limit the range. Typical
ranges vary depending on the types of materials and background RF (radio
frequency) noise in your home or business. The key to maximizing wireless range
is to follow these basic guidelines:

1. Keep the antenna of the DP-G321 in an upright position.

2. Keep the number of walls and ceilings between the DP-G321 and other
network devices to a minimum - each wall or ceiling can reduce your D-Link
wireless product’s range from 3-90 feet (1-30 meters). Position your devices
so that the number of walls or ceilings is minimized.

3. Be aware of the direct line between network devices. Awall that is 1.5 feet thick
(.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter) thick. At
a 2-degree angle it looks over 42 feet (14 meters). Position devices so that the
signal will travel straight through a wall or ceiling (instead of at an angle) for
better reception.

4. Building materials can impede the wireless signal - a solid metal door or
aluminum studs may have a negative effect on range. Try to position wireless
devices and computers with wireless adapters so that the signal passes
through drywall or open doorways and not other materials.

5. Keep your product away (at least 3-6 feet or 1-2 meters) from electrical
devices or appliances that generate extreme RF noise.



Setting up the DP-G321

Installing the Print Server

WARNING: Configuration problems may result ifthe Print Server is powered up without
first establishing its network connection. Follow this procedure to avoid complications at
the configuration stage.

1.
2.

Confirm proper operation of your printer before connecting the DP-G321.

When you have confirmed proper operation of your USB or parallel printer, turn
your printer power OFF.

. Confirm that your network is operating normally.
. Connect the DP-G321 to your network, using a straight-through CAT5 cable.

. While the printer is powered OFF, use the USB or parallel printer cable to con-

nect the DP-G321 to your printer.
Switch ON your USB or parallel printer.

Plug the DC power adapter into the DC 5V power socket on the rear panel of
the Print Server.

Plug the power adapter into a power outlet. This will supply power to the
DP-G321, as it has no external power switch. The green Power LED on the
Print Server’s front panel should illuminate steadily, and the Print Server’s
Self-Test will proceed.



Power ON Self-Test

Every DP-G321 has been factory-tested to operate properly.

When the DP-G321 is powered ON, it also automatically performs a Self-Test on
each of its major components. The final result of the Self-Test is signaled by the
state of the USB LED indicator following the Self-Test. Preliminary to the actual
component tests, the LED indicators are tested to confirm their steady and flashing
operation.

Immediately after power-up, three of the green LEDs should illuminate steadily for
several seconds. Then the USB LED should flash three times. Irregularity of the
LED during this LED test may mean there is a problem with the LED itself.

The actual component tests immediately follow the LED tests. A normal (no fault)
result is signaled by a flashing of the USB LED, followed by a darkened LED.

If the Self-Test routine detects any component error, then following the LED tests
the Self-Test will halt and the LEDs will continuously signal the error according to
the following table.

r ~
USB LED Faulty Component
low speed flashing Need to reload firmware
steady ON DRAM error
1long 2 short Timer INT error
1long 3 short Flash Protected
1long 5 short Flash Erase/Program error
1long 6 short LAN Controller error
1long 7 short LAN memory error
1long 11 short LAN I/O base error
1long 15 short Wireless LAN card detect error
1long 16 short Wireless LAN card CIS error
1long 17short Wireless LAN card I/O error

L 1long 18 short USB error )




Using the Web Configuration

Please use an Ethernet connection for the configuration of the DP-G321. Using a
CATS5 cable, connect the DP-G321 to the Ethernet-adapter equipped computer in
your network that you will be using for configuration. Open your web browser and
type http://192.168.0.10 in the address box, and press Enter. This set of numbers
is the default IP Address of your Print Server. Please note that the PC’s IP
Address must correspond with the Print Server’s IP Address in the same
segment for the two devices to communicate.

File Edit \Miew Favorites Tools  Help

I L 5
1 -1 | b
Yy 7 \ﬂ \ﬂ Ll |
fddress | ] http:(/192.168.0.10

When you enter the default IP address, the main screen of the Print Server’s con-
figuration will appear (see below). In addition to the product information, you can
access and control the Print Server’s configuration through four links on the top of
this main screen: Home, Configuration, Tools, and Help.

DP-G321
AlrPlus G Wireless Print Server

l
‘ :
=1

|||||




Using the Web Configuration (continued)
Home

Click on the Home
tab from the tools bar
of the main screen to
display information

DP-G321
AirPlus (G Wireless Print Server

(A Confgurationd _Tools | Help

about the DP-G321’s “, eweesas
System Status and vogel - oeoat
- Firmware Yersion o 1.00b (2004-03-22)
Prlnter Status. MAC Address : OO0FFO7 400E 61
IP Address o 192168010 (Manual)
Up Time 0days, 00:13:20
Home > R
S stem F‘::tz:Na;n: ; F‘f-«iDDEEEEW-UW .
y = gEee  § s
As shown here, the A .
. ,— otal PrintJobs 2
System d|Sp|ayS the - Tatal Print Size 0 KByles
StatUS Of your prlnt Printing Status Idle
. Mame
server, printer, and MG
network. Clicking i
Refresh will update e
the Informatlon, Printer Name PS-400E61-P3
Printer Speed High
Printer Status Off line
DeVice Status: Total PrintJohs 0
Information about the Toislent o aiares
print server, including oS e
the firmware version, WA
P
MAC/IP address, and Frotocal
the “up time” can be Srimon - e
found in this field. —
Printer Status: The ok [ e
. B . . Speed oo 100M bps
items in this field Duplex : ves
display information Tepackets a7
about the printer, Lk T
such as the given e e
name of the printer, @)
. Refresh
speed, printer status,

and the status of your
printing tasks, etc.

Ethernet Status: You can monitor the networking status in this field, including the
network connection, speed, and the packets status.



Using the Web Configuration (continued)

Home > Wireless
Click the Wireless button in the left column to display information about the
wireless LAN. Clicking Refresh will update the information.

DP-G321
A/rPlus (G Wireless Print Server

‘ Home Configuration Tools m
-' Wireless Status
: Connection Mode © Infrastructure

Link o Yes
j=i=1]n] o default {MAC ;000D 88 6513 8F)

— Channel % h
System Transmission Rate 540 bps
. Disable

WEP Encryption

il Ti Packets 460
T Errors 0
e Rx Packets ;1012
R Errors %
~—] @
Refresh

Wireless Status: The items in this field display information about the wireless LAN,
such as the connection mode (Infrastructure or Ad-Hoc), SSID, channel, data
transfer rate, WEP encryption, and the packets status.



Using the Web Configuration (continued)

Home >
Network

Click the Network

DP-G321
A/rPlus (G wireless Print Server

: | LU Configurationd _ Tools 1 Help
button in the left _ —
Column to d|sp|ay s/’ DHER/BOOTP Disahle (P:0.0.0.0)
. . UPRP Enagle (IP:192.166.0.108)
information about R — Enable (P 168.2501487)
the wireless LAN. - T
Clicking Refresh HRRRAE g
Wl” update the Total Print Size . 0 KBytes
. . Port (9100/8101/9102) Printing Status : Runnin
|nf0rmat|0n. Total Print Jobs 0 ’
Total Print Size : 0 KBytes
. IPP Printing Status . Running
AutoIP: Thisfield | | RRRRE 5
Contalns the Tatal Print Size : 0 KBytes
FTP Printing Status : Rurning
current settings of Total PrintJobs - O
. . Tatal Print Size : 0 KBytes
TCP/IP, IﬂC'UdIng E-mail Printing Status Running
Total Print Johs :0
DHCP/BOOTP,
UPNP d MAC’ Total PrintSize O KEytes
nP, an
Microsoft Networ k Printing
Rendezvous. The SMB (Over NetBEU) Printing Status Running
i 1 1 1 Total PrintJohs @ 0
Items In thIS fleld Total Print Size 0 KBytes
are configured in B (Over NE) Prining tatus - Running
Configuration > Lk adi WY
Network > TCP/IP. -
MAC AppleTalk Printing
AppleTalk Printing Status . Running
TCP/IP Printing: TPt oes 0
. Tatal Print Size : 0 KBytes
In this field, you can
monitor the status <)
. . Refresh
of your printing
tasks through TCP/IP.

Microsoft Network Printing: In this field, you can monitor the status of your
printing tasks through Microsoft Network.

Mac AppleTalk Printing: In this field, you can monitor the status of your printing
tasks through Mac AppleTalk.



Using the Web Configuration (continued)

Home > User

Click the User button in the left column to display the user’s information.

DP-G321
A/rPlus (G Wireless Print Server

Home m

Users Printing Log

[ mac :-_IP Name \Jobs | Size(KBytes) |

<

System
Refresh

Wireless

Network

[l -

User

Users Printing Log: The items in this field display the user(s) information, which
include the user(s) Mac address, IP address, name, and status of printing tasks.



Using the Web Configuration (continued)

Configuration

Click on the Configuration tab from the tools bar of the main screen to enter the
configuration page; it provides the configuration options that include System
Device and Port Setting.

System Device and Port Setting

This option will show you settings required to configure the DP-G321 Print Server.
Consult your printers owner manual for the PJL (Printer Job Language) and print
speed supported on your printer. Click the Save button on the bottom of the
configuration page to ensure the settings are updated and saved.

D = ;
Building He]t:‘wm]'-kslf}% DP-G321
A/rPlus (G Wireless Print Server

Configuration -!E!I.

System Device

Server Name . |PS-400ERT |

Location i | |

f_

Admin Cantact | |

System
Password o MewPassword - |
Confirm Again £ |
[ ’
Wireless
Port Setting
[ — UsB . PortName |PS-400EE1-U1 |
Network
Description + ‘ |
— — PJL Printer JNe ¥
User S—
UsB? Port Mame - PS-400E61-2 |
 EEE— Description . \ |
SHMP — ==
PJL Printer ‘No V|
LPT . PortMame - PS-00ERTP3 |

Description 2 ‘ |

Speed ;. High Vi

PJL Printer no ]

9 O

Apply Cancel




Using the Web Configuration (continued)

Configuration > System Device and Port Setting

System Device

In this field, you can configure the basic information of your print server.
Server Name: Assign a name to the print server.

Location (optional): Assign a location for the print server.

Admin contact (optional): Assign the Admin’s contact name for the print server.

Password: Enter the Administrator password (3-8 characters). To set up the
password, please enter the password in the New Password box, and then enter
the same one again in the Confirm Again box.

Port Settings

In this field, you can assign the Port Name for the print server, and the description
for the USB or printer ports. It also allows you to select the PJL Printer setting (Yes
or No).

NOTE: PJL (Print Job Language) has certain job requirements that must be met to
work correctly. for more information, please refer to your printer’'s manual.

Configuration > Wireless

DP-G321
A/rPlus G Wireless Print Server

| | tome TV Toois | Help |

- Wireless interface
=" Cannscaon Mode & nfragscture

) Ag-Hoe

SeID dedaul

SR [ Sito Survay |
System Sit Surary
Wirgless Channgl [~
e o v .
WEP Enciyplion
Nanwark WEP Encryplion @ Disable 064 bits O 120 bits
WEP Ky Fanmiat Cagcn ®HEX
—_— Ve
User 4

ay2
Kary 3
Kay 4

Enerpt Data Tranemiseions Ueing | Kine 1 58

0 (e
@Long O Shan

2 Open Systern O Snaned Key & Bot

2 o

Apply Cancel




Using the Web Configuration (continued)
Configuration > Wireless

Wireless Interface
Connection Mode: Select one of two connection modes:

u Infrastructure (default): Connect to an existing wireless AP or
router in a WLAN.
u Ad-Hoc: Connect to wireless clients in the Peer-to-Peer mode.

SSID: Assign the SSID in this box. You can manually input the name or select one
from the pull-down menu. To search the available print server within the network,
click the Site Survey button.

Wireless Channel: Select the channel from the pull-down menu. The default
setting is 6.

Transmission Rate: Select the data transmit rate from the pull-down menu. The
default setting is Fully Automatic.

WEP Encryption

This field allows you to configure the settings of data encryption. Please remember
that the WEP key must be set before the data encryption is enforced.

WEP Encryption: This option allows you to select Disable, 64-bit, and 128-bit for
encryption setting.

WEP Key Format: You can decide the network key to be encoded by ASCII (ASCII
characters) or HEX (hexadecimal digitals). 64-bit WEP encryption uses a 10
hexadecimal character key. The WEP encryption key must match the WEP
settings on your AP or wireless router to connect properly.

Then, enter the key(s) for the network in the Key box (1-4).

Advanced Setting

Beacon Interval: Enter the number for the beacon interval in milliseconds.

Preamble: This option allows you to set the length of the preamble. Setting options
are:

[ Long: set to 144 bits

[ | Short: set to 72 bits.

Authentication Type: You can set the authentication type by selecting the settings:
Open System, Shared Key, and Both.



Using the Web Configuration (continued)

Network

System

Wireless

Network

User

SNMP

il

A/irPlus (G Wireless Print Server

DP-G321

m Configuration -!!!I-

\
aad
il

TCPAP
IF Address

* DNS Server Address

| @ manually Assign

IP Address 192.168.0.10

Subnet Mask 255.255.255.0
* Default Gatewsy 19216801

| © Automatically Assign

1. [192.168.01

2 [e222

* These entries must be filled to enable e-Mail hase printing

UPnP
MAC Rendezvaus
Second HTTP Port

Microsoft Network
Workgroup

AppleTalk
AppleTalk Zone

UsB1

LigB2

LFT

: Chooser Mame

@ Enable O Disable
@ Enable O Disable

CEnable @ Disable

Port Number : |0
(For Remote Yeb Configuration and IPP Printing)

AWEORKGROPP

- lme

: PE-400E61-U1

Frinter Type 3 _Laset‘Wnter
PostScript Level . .Level. 2._
Font Group Standard 35

: ChooserMame

Frinter Type
PostScript Level
Font Group
Chooser Mame
Printer Type
PostScript Level

Font Group

: PE-400E61-U2

- |Laserdriter

: .LE\."E|.2”Q.
Standard 35 [
PE-400E61-F3

3 Lase!’\/\t‘_r_\te_(
Level 2 [E;J
Standard 35 [

2 O

Apply Cancel




Using the Web Configuration (continued)
Configuration > Network
TCP/IP

This field contains three options that allow you to configure the TCP/IP setting:

IP Address: This option allows you to set the IP address manually or automatically.
When you choose Manually Assign, you should enter the related information in the
following boxes, including IP Address, Subnet Mask, and Default Gateway.

DNS Server Address: Input the DNS (Domain Name Server) IP address provided
by your ISP.

UPnNP: This option allows you to enable or disable UPnP mode.

MAC Rendezvous: This option allows you to enable or disable MAC Rendezvous
mode.

WEP Encryption: This option allows you to select Disable, 64-bit, and 128-bit for
encryption setting.

Microsoft Network

Enter the name of the Workgroup that you want the print server associated with in
this field.

AppleTalk

Enter the AppleTalk Zone name in the box. In the following options, enter the related
configuration, such as the printer type.

USB1/USB2 / LPT

Chooser Name: Display the print server name.
Printer Type: Enter the printer’s type in this box.
PostScript Level: Select from the pull-down menu (Level 1 or Level 2).

Font Group: Select from the pull-down menu.

TIP: Once you have changed the settings in each option, click Apply to store the
settings.




Using the Web Configuration (continued)

Configuration > User

DP-G321
A/rPlus (G Wireless Print Server

| | Home MNONTPMETN  Tools | Help
' e Printing Control
Enahle User Printing Contral & () yes @ Mo a g’
Apply Cancel
————
Add User  © User Name i | | [ Add ]
i - ¥
(Example 00 80 CAB AT B2 C3H)
Printing Access  © @ves ORo
I e
BIERIEES Delete User © | v|
User List f .éName Tmac jPrintingAccess |
User
—
SNMP

Printing Control
By configuring the Enable User Printing Control option (Yes or No), the user in
the User List is permitted to access the print server or not.

Define Users

You can add/delete the user(s) to/from the User List. The User List at the bottom
of the screen displays the current defined user and related information for the
print server.

Click Apply to save the changes.



Using the Web Configuration (continued)

Configuration > SNMP

DP-G321
ArPlus (G Wireless Print Server

[ Home NWUICTACIE  Tools | Help

SNMP Management

Community 1 Mame :
Access Right - | Readfrite v
Community 2 Mame ]
Access Right :
Community 3 Mame i
Wireless Access Right - | Read Only %

Network a @

Apply Cancel

System

|

User

SHMP

SNMP Management
SNMP (Simple Network Management Protocol) is a set of protocols for managing

complex networks.

Community 1/2/3: Enter a name in the Name box,
and configure the Access Right
by selecting Read Only or Read/Write
from the pull-down menu.

Click Apply if you have made changes.



Using the Web Configuration (continued)

Tools

Click on the Tools link from the tools bar of the main screen to enter the Tools
Page; it provides the control options that include Print Test, E-mail, Reset,
Upgrade, and Backup.

Tools > Print Test

DP-G321
A/rPlus (G Wireless Print Server

__Home I Configuration SNSRI/ S Help

Print Test
Part Selection
Printtest function requires Mative DOS mode support on your USH printer.

|

@ usen
Print Test O use2
QO LPT
E-mail a

Apply

Reset

Upgrade

Backup

i

Print Test
Click Test to print a test page from the selected USB or parallel port.



Using the Web Configuration (continued)
Tools > Email

D Link o
A/rPlus G wireless Print Server

Home oo [IFTER

E-mail Account

\
\

Print Server E-mail Address

Incoming E-mail (POP3) Server Address
Print Test Outgoing E-mail (SMTP) Server Address
Account Mame
E-mail Passward

2 O

Reset Apply Cancel

E-mail Notification
Upgrade Enable e-mail nofification for printer status changing @ ®vyes O Na
Admin E-mail Address
(Use t'to separate multiple e-mail address)
@ O

Apply Cancel

E-mail test will send an e-mail to Admin's e-mail address.
Do you want to tast an e-mail account?

il

Backup

E-mail Printing

Support ASCI Text only.
To uge this function, please configure you Gateway and DS seftings on Network Page

E-mail Printing : OEnable © Disable
Port Salsct © Quset @usez OLPT
Receive E-mail Interval N {rminutes)
Apply Cancel
Receive an e-mail and a print out.

E-mail Account

You can assign an E-mail address to the print server, so that the mail from the
account can be printed out directly through the printer (ASCII text only). To enable
this function, enter the E-mail account in the Print Server E-mail Address box.

Incoming E-mail (POP3) Server Address: Enter the server address that is
used to receive your E-mail in this box.

Outgoing E-mail (SMTP) Server Address: Enter the server address that is
used to send your E-mail in this box.

If your mail server needs to verify the user when sending E-mail, the DP-G321 will
apply the same Account Name and Password to the mail server as it does when
receiving E-mail.



Using the Web Configuration (continued)

Tools > Email (continued)

E-mail Notification

You can set the print server to send a message through E-mail when the printer
status changes. To enable this function, set the Enable e-mail notification

for printer status changing option to Yes. Then, input the administrator’s Email
address in the Admin E-mail Address box.

E-mail Printing

E-mail Printing (ASCII Text Only): Select Enable to enable the E-mail printing
function.

Receive E-mail Interval: Enter the number in this box to set up the time (in
minutes) to check/receive E-mail regularly.

Test E-mail Account: Click Test to send a test E-mail to the given
administrator’s Email address.

Receive E-mail: Click Yes to immediately check and receive E-mail, and then
print out the mail when available.

Reset

DP-G321
AirPlus G Wireless Print Server

Reset \ Home - Tools m
Click Apply to “/, et

immediately reset )
the print server.

Apply
Print Test
Factory Reset

All settings on this device will now be restored to the factory defaults

Factory Reset

Click Apply to @
reload the factory oo
default settings of

the print server. Upgrade

Backup

il EE




Using the Web Configuration (continued)
Tools > Upgrade

DP-G321
A/rPlus (G Wireless Print Server

|__Home 1 Configuration SNSRIV RN Help

Uparade
Mote: Please make sure that vou use the correct firmware hefore you proceed. [fyou do not
knowe sehich firmweare ywou should use, please contact your local dealer for technical support.

Current Firmware Version and Date; 1,000 (2004-03-22)

Print Test
Select A Firrmware File |

E-mail a a

Apply Cancel

Reset

fIiA -

Upgrade

Backup

i

Firmware Upgrade

When a new version of firmware is available (e.g., downloaded from the
manufacturer’s website), you can upgrade the firmware of your print server. Click
Browse to locate the firmware file, then click Apply.



Using the Web Configuration (continued)

Tools > Backup

DP-G321
A/rPlus (G Wireless Print Server

Home L Hep

Backup Device Configuration to File
Dowouwantto backup the configuration to file?

@

Apply
Print Test Restore Device Configuration from File
Select A Configuration File | Browse... |
E-mail
@ O
Apply Cancel

Reset

H0EA ‘-

Upgrade

Backup

Backup Device Configuration to File
Click Apply to backup your current configuration of the print server to file and then

save in the computer.

Restore Device Configuration from File
You can reload a configuration that you saved before. Click Browse to point to

the backup file, and then click Apply.



Using the Web Configuration (continued)
Help

DP-G321
A/rPlus G Wireless Print Server

| Help

Help

For U5 customer support, please visit us online at hitpisupport.dlink.com

Home
System
Wiraless
MNetwork
User

Configuration
Systemn
Wireless
Metwark

User

SHMP

Tools
Print Test
E-mail
Reset
Upgrade
Backup

Click on the Help link from the tools bar of the main screen to enter the Help Page.
This page provides a link to D-Link’s support website. D-Link’s support website will
provide the most up to date information on your DP-G321 Print Server. Please
check the website regularly for product and firmware updates. Click on each topic
for more information on any screen in the Web Configuration Utility.



TCP/IP Printing for Windows XP

Open the web browser, and type in the IP Address of the DP-G321.
For example, type http://192.168.0.10 into the Location or Address field. Press
the Enter or (Return) Key.

Note:

The PC’s IP Address must be in the same subnet as the Print Server’s IP
Address for the two devices to communicate. (For example, if your Print
Server’s IP Address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP Address should be 192.168.0.x, where x is a value
between 1-254, excluding 10.) See Networking Basics: Assigning a Static IP
Address in this manual to find out how to change an IP Address.

File Edit View Favorites Tools  Help

Wy o & |ﬂ @ ;j /

Address | @] hitp:/f192.168.0.10

DP-G321
AlrPlus G Wireless Print Server

| (L configuration] _Tools | Heo |

HY




TCP/IP Printing for Windows XP (continued)

At the Configuration window, write down the Port Names for future reference.
You will need this information later in the configuration process.

DP-G321
AirPlus (G Wireless Print Server

m Configuration -E_

e

System Device
Server Narne © |PE-400ER1 ‘
Location : ‘

Admin Contact al

System

Password o Mew Password

|

Confirm Again
Wireless

Port Setting

T usa :[ Port Narne . |Ps-400E81-U1 | ]
Description | |
PJL Printer Mo~
usa2 :[F‘ort Namg  [Ps-400E61-U2 | ]
Description a3l |
P.L Frinter N v
LPT : [Port Harme |P=-4n0E61-P3 | ]
Description 2 | |
PJL Printer 2| No [

@ 9

Apply Cancel




TCP/IP Printing for Windows XP (continued)

DP-G321
A/rPlus (G Wireless Print Server

Configuration -!E_

Wireless Interface

-

ConnectionMode @ |nfrastructure
O Ad-Hoe
jat=][n] . |default
System Site Survey
Wireless Channel :|B [:J
Wireless Transmission Rate FuIIyAutDmatic
WEP Encryption
T —— ;
WEF Encryption . @ Disable O 64 bits O 128 bits
WEP Key Format o Oascl ®HEX
—
Key 2
P Key 3
SHMP
Key 4

Encrypt Data Transmissions Using : | Key 1 Q

Advanced Setting

Beacon Interval - [1o0 .(ms)

Preamble ¢ ®Long O short

Authentication Type O Open Systern (O Shared Key & Both

9 O

Apply Cancel

Select your Connection Mode.

Enter the SSID of the remote access point or wireless router you wish to
connect to.

If you would like to set WEP Encryption, select the encryption level and the
key here.

Click Apply.



TCP/IP Printing for Windows XP (continued)

When you select TCP/IP Protocol at the Network window, the screen below
appears. (We recommend that you keep the default settings as shown.) If you need
to make changes, make sure to click Apply after you have made the changes. (You
may wish to make a note of the IP address.)

DP-G321

Systern

o
i

Wireless

Network

User

i

A/rPlus (G Wireless Print Server

| Home Configuration [ Tools | Help

TCPAP

IFaadrass @ Manually Assign
IP Address 1921668010
Bubnet Mask 256 256.266.0

* DNE Server Address

* Defaull Gateway

O Automatically Assign

4 [192.188.01
2. 1222

192.168.0.1

* These entries rmust be filled to enable e-Mail base printing

UPnP
MAC Rendezvous
Second HTTF Port

@ Enable O Disable
@Eenable O Disable

O Enalle @ Disable
Port Mumber ; |0

{For Rermote Web Conﬁguration amd'll':'F' Printing)

SHMP
Microsoft Network
Workgraup |WORKGROUP
AppleTalk

AppleTalk Zone

-

uset : Chooser Mame : PS-400EE1-L1
Printer Type - |Laseririter
PastScript Level o | Lewel 2 L:j
Font Group ;| Standard 35 Ei

usB2 : Chooser Mame : PS-400EB1-U2
Printer Type - |Laserdriter
PostScript Level : .LeveIZIEJ
Fant Group - | Standard 35 L:j

LPT : Chooser Mame : PB-400ER1-P3
Printer Type 3 Laser’Wriler
PastScript Level - | Lewel 2 [1
Font Group - | Standard 35 L:j

9 O

Apply Cancel




TCP/IP Printing for Windows XP (continued)

"% Printers and Faxes
Go to Start > Settings >

Printers and Faxes > File Edit View Favorites Tools  Help
Add a Printer

_.af" I ___s" | ﬁ J’;- ) Search

Address | Printers and Faxes

#)

Printer Tasks

F,
{

=[] Add a printer
& Set up Faxing )
|Start the Add Printer Wizard,

Add Printer Wizard

Welcome to the Add Printer
Wizard

Thiz wizard helps you install a printer ar make printer
connechions.

= |F pou have a Plug and Play printer that connects

1 through a USE part [or atw aother hot pluggable
port, such as IEEE 1394, infrared, and so on. you
do not need to use this wizard. Click Cancel to
cloge the wizard, and then plug the printer's cable
into your computer or point the printer toward pour
computer's infrared part, and turh the prinker on,
Witdows will automatically install the printer far you,

To continue, click MNest.

Click Next. < Back

Cancel




TCP/IP Printing for Windows XP (continued)

Select Local Printer.

Add Printer Wizard

Local or Network Printer
The wizard needs ta know which type of printer to set up.

Select the aption that describes the printer you want to use:

 { acal printer attached to this computers

Deselect Automatically
detect and install my
Plug and Play printer.

Click Next.

Select Create a new port. At

the pull-down menu, highlight
Standard TCP/IP Port.

> I~ Automatically detect and install my Plug and Play printer

& ngtwark printer, or a printer attached to anather computer

‘:E) To get up a netwark printer that is not attached to a print server,

uze the "Local printer” option.

< Back ' I Next » I | Cancel

——

Add Printer Wizard

Select a Printer Port
Computers communicate with printers through ports.

Select the poit you want your printer to use. [f the port is not listed, you can create a

ne port.

r Uze the follawing port: ILPT‘I [Recommendead Frinter Part]

=

Hiole: st oamputers ise the LETA- port t communicate with & lacel printer

The connector far this port should look something lilke this

e

—

Click Next.

Click Next.

(% Create a new port:
Type of part

Add Standard TCP/IP er Port Wizard

Before conlinuing be sure that:
1. The device is tuned on.

To continue, click Nest

2. The netwoark iz connected and configured.

Welcome to the Add Standard
TCP/IP Printer Port Wizard

You use this wizard to add a part for a nebwork, printer.

Baok

Cancel |




TCP/IP Printing for Windows XP (continued)

Type in the IP address of
the Print Server (i.e.
192.168.0.10). The Port
Name will automatically
be filled in.

Select Custom.
Then click Settings.

Add Standard TCP/IP Printer Port Wizard 5'
Add Port
Far which device do vou want to add & port™ N
==

Enler the Printer Name or IP address. and a port name for the desired device

_» Printer Name or [P Address: IT 32.168.0.10
—_— ot [AEERE

< Back | Mext > I Cancel I

Add Standard TCP/IP Printer Port Wizard

Additional Port Information Required é
The device could not be identified
N

The detected device is of unknown type. Be sure that:
1. The device is properly configured.
2. The address an the previous page it carrect,

Either carect the address and perform another search on the network: by returning to the
previous wizaid page or select the device type if you are sure the addiess is consct

Device Type
) Standard

Select LPR.

’ (&) Custom

< Back l[ Next > ,][ Cancel ]

Configure Standard TCP/IP Port Monitor

Input the Port Name of
the port being used by
the printer.

Click OK.

Puait Settings \
Forl Hame IP_152168.0.10 |
Printer Name of IF Address: ‘192188010 |
Protocol
> O Raw @LPR

ngs

LPFR Settings

»i PS-116688-U1 |
|

[] LPR Byte Counting Enabiled

[ 8NP Status Enabled




TCPI/IP Printing for Windows XP (continued)

Click Next.

Click Finish.

Highlight the printer, as shown.
If the desired printer is not on
the list, click Have Disk and
insert the printer driver disk that
came with your printer to install
the printer drivers.

Click Next.

Add Standard TCP#IP Printer Port Wizard ¢

Additional Port Inf ion R

The device could not be identified

The detected device is of unknown type. Be sure that:
1. The device iz properly configured
2. The address on the previous page iz comect.

Either cormect the addiess and perform another search on the nebwork by returning to the
previous wizard page or select the device pe if pou are sure the address is comect.

Device Type
O Standard | Genene Metiverl
(%) Custom

ure Standard TCP/IP Port Monitor

Part Settings |

Part Mame: [IF_132188.0.10 |
Frinter Mame or [P Address [192188.010 |
Protosal
3 Raw & LFPR

Flaw Settings

LPR Settings
Queue Mame: | PS-116688-U1 |

[]LPR Byte Counting Enabled

] SMMP Status Enabled

Add Printer Wizard

Install Printer S oftware
The manutacturer and model determine which printer software to use.

Select the manufacturer and model of vour prirter. If your printer came with an installation
disk. click Hawe Disk. If your printer is not listed, consult pour printer documentation far
compatible printer software.

Manufacturer 4| Printers &

Compan - | 53

g:"‘ta?’”d“m 5 Epson Stylus COLOR 760 ESC/P 2

Digital ¥ Epson Stylus COLOR 777 ESC/P 2 -

) || B o sype clm emescres v
f‘% This driver is digitally signed. [ \windaws Update l [ Have Digk. J

Tell me why diver signing is important

Y e |
< Back l Nest = ' Cancel




TCP/IP Printing for Windows XP (continued)

Name Your Printer
“fou must assign a name to this printer.

Type a name for this printer. Because some programs do not suppart printer and server
name combinations of more than 31 characters, it is best to keep the hame as short as

At this screen, you can input a bl
name for the printer.

CIle Next. < Back l' Next > " Cancel

Print Test Page
To confirm that the printer iz installed properly, you can print a test page

Do you want ta print & test page?
® s
= No

CIle NeXt ﬂ- Cancel

Add Printer Wizard

Completing the Add Printer
@ Wizard

ou have successfully completed the Add Printer \Wizard,
You specified the following printer settings:

Mame: Epzon Stylus COLOR 740 ESC/P 2
Share name:  <Mot Shared:

Port: IP_132168.0.10

b odet Epson Stylus COLOR 740 ESCAP 2
D efault: Yes

Test page: Ma

To close this wizard, click Finish.

CIiCk FiniSh. < Back J Finish Cancel




TCP/IP Printing for Windows 2000

Open the Web browser, and type in the IP Address of the DP-G321.
For example, type http://192.168.0.10 into the Location or Address field. Press
the Enter or (Return) Key.

Note:

The PC’s IP Address must be in the same subnet as the Print Server’s IP
Address for the two devices to communicate. (For example, if your Print
Server’s IP Address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP Address should be 192.168.0.x, where x is a value
between 1-254, excluding 10.)

File Edit ‘Wiew Faworites  Tools  Help

Dk - @ - [¥ B & L

Acdress | ] httpif192,168.0,10

DP-G321
AlrPlus G Wireless Print Server

\
®-
=

-----
:::::

HY




TCP/IP Printing for Windows 2000 (continued)

At the Configuration window, write down the Port Names for future reference.
You will need this information later in the configuration process.

DP-G321
A/rPlus (G Wireless Print Server

m Configuration -ﬂ_

\
“’

System Device
Server Name PS-400EGT |
Location |

Admin Contact |

System

Password Mew Password

|

Confirm Again
.
Wireless
Port Setting
[ r— usa Port Name |Ps-400E61-U1 |
Network
Description | |
e PJL Printer Mo v
User
usB2 [F‘ort Name |PS-400E61-U2 | ]
e —— Description | |
SHMP
PJL Printer |Ng v
LPT [Pon Name |PS-400E81-P3 | ]
Cescription | |
PJL Printer Mo w

9 O

Apply Cancel




TCP/IP Printing for Windows 2000 (continued)

DP-G321

A/rPlus (G Wwireless Print Server

Configuration [RCE IR

[l ‘-

Wireless Interface
Caonnection Made

@ Infrastructure

O Ad-Hoe
S5ID © |default
System
Wireless Channel LB D

Wireless

Transmission Rate

Fully Automatic

WEFP Encryption

[T ;

WEF Encryption © @ nDisable O 64bits O 128 bits

WEP Key Farmat o QOascll @ HEX

I T—
Key 2

i Key 3

SHMP

Key 4

Enerypt Diata Transmissions Using : | Key 1 Q

Advanced Setting
Beacon Interval
Freamhle

Authentication Type

[100 Jimey

@ Long O Short
C open System O Shared Key @ Both

@ ©

Apply Cancel

Select your Connection Mode.
Enter the SSID of the remote access point or wireless router to which you wish to
connect.

If you would like to set WEP Encryption, select the encryption level and the key here.
Click Apply.



TCP/IP Printing for Windows 2000 (continued)

DP-G321
AirPlus (G Wireless Print Server

‘ [ Home Configuration Tools 4 Help
“, = TcPap
Faddress, @ Manually Assign

IF Address 192.168.010

Subnet Mask - |2BR 2RR 2ER 0
System -
* Default Gateway - |192.168.0.1

OAutnmatiEally Assign

i

Wireless
* DNS Server Address 1./192.168.0.1
2 |aezz
Network * These entries must be filled to enable e-Mail base printing.
UPNP @ Enable O Disable
Bl MAC Rendezvous
@ Enable O Disable
Second HTTF Port i Enable @ Disable
Port Mumber ;|0 ) i
T SNMP (For Remote Web Configuration and IPP Printing)

Microsoft Network

Warkgroup - [WORKGROUF

AppleTalk

AppleTalk Zone 1

UEB1 Chooser Name PS-400E61-U1
Printer Type Lasetiriter
PostScript Level [Levelz [
Font Group - | Standard 35 Ej

usB2 Chooser Mame : PS-400EG1-U2
Printer Type . |Laserdriter
PostScript Level - | Level 2 D
Font Group | standard 35 [

LPT Chooser Name : PS-400E61-P3
Printer Type 3 Lase!’Wnter
PostScript Level - |Lewel 2 [:j
Font Group | Standard 35 [

@ O

Apply Cancel

When you select TCP/IP Protocol at the Network window, the screen below
appears. (We recommend that you keep the default settings as shown.) If you need
to make changes, make sure to click Apply after you have made the changes. (You
may wish to make a note of the IP Address.)



TCP/IP Printing for Windows 2000 (continued)

Go to Start > Settings >
Printers.

Double-click on the Add
Printer icon.

Click Next.

B3 Printers O] x|

J File Edt “ew Go Favoites Help ‘

4-.-».@‘&% ‘ ?
Bk e lp Cut Copy Paste

J Address I Printers

[

Add Frinter

Printers

Add Printer

The add
Printer wizard
walks you
step-by-step
through
installing a
printer, Just
follow the
instructions
on each
sCreen.

Add Standard TCP/IP Printer Port Wizard

B

Welcome to the Add Standard
TCP/IP Printer Port Wizard

“Y'ou uze thiz wizard to add a port for a network printer.
Before continuing be sure that:

1. The device is turned on.
2. The network iz connected and configured.

To continue, click Mext.

Back Cancel




TCP/IP Printing for Windows 2000 (continued)

Local ar Network Printer
|5 the pimiter atiached (o pow compules?

Select Local Printer. et L DTy iR Sfact o

= Mmdawmdnﬂdwﬂagmdﬁwnm
™ Matwork: printes

s (Cion J)_ oot |

Mew Printes Detection
Thus ward supomalically detects and mstalis rew Fiug and Play prrers

b ‘whindows wat unabibe 1o detect sy Plug and Plap prirters. Click. Nest i you
(AN ant o el e ket mernasly

Click Next. Carest_|

;
Select the Printe: Port
Select Create a new port at the Conpibmi st et i e Sionss ok
pull-down menu, highlight Standard Skt et o s . i e i o
TCP/IP Port. AR
Fait | Deserpion | Frintes [ =
LPTY: Paritor Port

LFT3. Prirfer Poit —

COM1  SeialPat
COM2  SsialPou
(RELE} Satial Pt :J

Hale: Most compubers uze the LPT1: port ba commurcale with a local prinbes.

—» v Create & new part
(AL - |

Tupe:

Click Next. ok [ et J) coo |




TCP/IP Printing for Windows 2000 (continued)

Add Stanudard TCP/IP Printer Port Wizard =

welcome to the Add Srandard
TCP/IP Printer Port Wizard

o use this wizard o add & poil for 4 nebeoek. perte).
Balors conlinang be s thar

1. The deice 15 bured on
7 The reanik i connected ard configued

Tas vonliiae, chok Haw

Click Next.

Type in the IP address of the Print

Server in the Printer Name or IP L
Address field. The Port Name field
will automatically be filled in.

Enter the Printer Name or IP address, and a port name for the desired device.

—} Printer Name or IP Address: ‘132-159-0 1 |

} Port Name: ‘IF_-1_B_21_EBETEI |

) [fr—
CIle NeXt < Back Hext > Cancel

#dd Standard TCP/IP Printer Part Wizard X
i
The device could nat be identifisd. N

The detected device iz of unknown type. Be sure that:
1. The device is properly configured.
2. The address on the previous page is correct.

Either correct the address and perform another search on the nebwaork, by retuming to the
previous wizard page o select the device tpe if you are sure the address is comect.

Select “Custom.” Hvied Tine
Then click on Settings. O Standd

- ([Csetin: |

< Back ][ Mext > ][ Cancel




TCP/IP Printing for Windows 2000 (continued)

ure Standard TCPAIP Port Monitor

i Poit Settings
| Port Name, IP_132188.0.10 |
| Printer Name of IP Address: ‘192188 oo
|
Protocol
Select LPR. P O oL

| Faw Settings

Input the port name of | iRsenng:

the port being used by i  gla |
. [[]LPR Byte Counting Enabled

the printer.

[ 8NP Status Enabled
\ |

Click OK.

Add Standard TCP/IP Printer Port Wizard

Additional Port Information Required
The device could not be identified

The delected device s of unknown lype. Be sure that
1. The devics is properly configured
2 The addiess an the pravious page is corect

Either conect the address and perform another search on the network by retuming to the
previous wizard page or select the device type if you are sure the address is comect,

Heviseilvgs
O Standard D=

(&) Custorn Settings..

Click Next. < Back Net > Cancel

Add Standard TCP/IP Printer Port Wizard

Completing the Add Standard
TCP/IP Printer Port Wizard

“rou have selected a port with the following characteristics.

SNMP: No

Pratacol: LPR. PS-116633-U1
Device: 182168010

Port Name:  IP_192.168.0.10
Adapter Type:

To complete this wizard, click Finish.

CIiCk Finish, < Back l[ Finizh ] [ Cancel




TCP/IP Printing for Windows 2000 (continued)

Highlight the printer, as shown.
If the desired printer is not on
the list, click Have Disk and
insert the printer driver disk that
came with your printer to install
the printer drivers.

Click Next.

At this screen, you can input a
name for the printer.

Click Next.

Add Printer Wizard

Install Printer 5oftware
The manufacturer and model determine which printer software to use.

‘._;_\ Select the manufacturer and model of wour printer. IF your printer came with an installation
@ digk, click Hawe Disk. If pour printer ig not listed, congult your printer documentation for
compatible printer software.

Manufacturer S| Printers i

Compag o | B

Dataproducts b= H

B:;ﬁ;‘x .‘a}' Epson Stylus COLOR 777 ESC/P 2 -

= || sprSpmcoLon cn e
:Q Thig driver iz digitally signed, [ ‘Wwindows Update ] [ Have Disk... J

Tell me why driver signing is important

< Back ' Mest » ' Cancel

Add Printer Wizard

Name Your Printer

You must assign a name Lo this printer. w‘g

Type & name for this printer. Because some programs do not support printer and server
name combinations of mare than 31 characters, it is best to keep the name as short as
possible.

FErinter name:

< Back H Mext > }'[ Cancel J




TCP/IP Printing for Windows 2000 (continued)

Select Do not share this printer.

Printes Shating
“fow can thare Bus porder veth ciiver netyecrk uzers

Indicate whether pou want thes printer to be avaiabie to ofher users. If you shae this
prinkex, you must piovids & shate name.

Click Next.

Select Yes to print a test page.

Click Next.

Click Finish.

The printer is now ready for
printing with Windows 2000 on
your network.

& [Dg not share this printer
" Shweas |

< Back li Neat > i' Cancel |

Prrinit Test Page
Ta canlem that the punker i nskaled popeilp. you can pond 3 lesl page

Do you want to pint 3 test page 7
= fred
™ Mo

g () T

Add Printer Wizard

Completing the Add Printer
Wizard

You have successfully completed the Add Printer Wizard.
“f'ou specified the following printer seftings:

Name: Epson Stylus COLOR 740 ESC/P 2

Share name:  <Mot Shared>

Part: IP_132168.0.10

Model: Epson Stylus COLOR 740 ESC/P 2
Default Yes

Testpage: Mo

To close this wizard, click Finish

Finish |




TCPI/IP Printing
for Windows 98SE/Me

Open the web browser, and type in the IP Address of the DP-G321.
For example, type http://192.168.0.10 into the Location or Address field. Press

the Enter or (Return) Key.

Note:

Your PC’s IP Address must be in the same subnet as the Print Server’s IP
Address for the two devices to communicate. (For example, if your Print
Server’s |IP Address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP Address should be 192.168.0.x, where x is a value
between 1-254, excluding 10.)

File Edit ‘Wiew Faworites  Tools  Help

D= - @ - [ & | S

fddress | &] hitp:}j192.168.0.10

DP-G321
AlrPlus G Wireless Print Server

Drvkes St

\
®-
=

-----
:::::
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TCPIIP Printing for Windows 98SE/Me (continued)

At the Configuration window, write down the Port Names for future reference.
You will need this information later in the configuration process. The Port Name
shown here is only an example.

DP-G321
A/rPlus (G Wireless Print Server

m Configuration -ﬂ_

__'___ System Device
Server Name PS-400EGT |
Location | |
Adrnin Contact | |
System
Passward Mew Pagsword
Confirm Again
.
Wireless
Port Setting
[e— UsB1 Port Name |Ps-an0ERT-U1 |
Network
Description | |
— PJL Printer Mo v
User
usez [F‘ort Name |Ps-400ERT-UZ | ]
I w— Description | |
SHMP
PJL Printer |Ng v
LPT [Pon Name |Ps-400E61-P3 | ]
Cescription | |
PJL Printer Mo w
Apply Cancel




TCPIIP Printing for Windows 98SE/Me(continued)

DP-G321
A/rPlus (G Wireless Print Server

Configuration -!E!I-

Wireless Interface

f -

Connection Mode " @ Infrastructure
O Ad-Hoe
S8ID o |default
System Site Survey
Wireless Channel |6 [
Wireless Transmission Rate | Fully Automatic
WEP Encryption
ST :
WEF Encryption . @Dpisable O 64 bits O 128 bits
WEP Key Forrat COagcl ®HEX
—
KEY1
Key 2
o Key 3
SHMP
ey 4

Enerypt Data Transmissions Using ;| Key 1 [+

Advanced Setting

Beacon Interval : .1DD .(ms)

Preamble . ®Long O short

Authentication Type (O Open Systern O Shared Key & Both

@ O

Apply Cancel

Select your Connection Mode.

Enter the SSID of the remote access point or wireless router to which you wish to
connect.

If you would like to set WEP Encryption, select the encryption level and the key
here.

Click Apply.



TCPI/IP Printing for Windows 98SE/Me(continued)

When you select TCP/IP Protocol at the Network window, the screen below will
appear. (We recommend that you keep the default settings as shown.) If you need
to make changes, make sure to click Apply after you have made the changes. (You
may wish to make a note of the IP address.)

DP-G321

AirPlus (G Wireless Print Server

Configuration -E_

TCPIP
IFaadrass @ Manually Assign
IP Address < [192.768.0.10
SubnetMask - |2B5.265.286.0
System
+* Default Gateway - |192.168.0.1

Wireless

i

Network

User

i

*DNS Server Address ©

O autamatically Assign

1. 19218801
2 4222

* These entries rust be filled to enable e-Mail base printing.

UPnP
MAC Rendezvous
Second HTTP Port

. @Enanle O Disable
. @Enanle O Disable
© (DEnable @ Disable

Port Murmber : |0

{Far Remote Wieb Configuration and IPP Printing)

SNMP

Microsoft Network

\Warkaraup : WORKGROUP

AppleTalk

AppleTalk Zone i

UgHE1 Chooser Name FS-400E61-L1
Printer Type Laserriter
FaostScript Level L_evel E D
Font Group Standard 35 [

usB2 Chooser Name P3-400E61-U2
Printer Type Laserhriter
PostScript Level .Level EEJ
Fant Group Standard 35 L__J

LPT Chooser Name FS-400E61-P3
Printer Type Laserriter
FostScript Level Lewvel 2 Ej
Font Group Standard 35 |_:]

9 O

Apply Cancel




TCPIIP Printing for Windows 98SE/Me (continued)

Network EdEd

Configuration I Identificatiunl Access Eu:untrull

The following network, components are installed:

Go to Start > Settings > Client for Microzoft Metworks -
Control Panel. Micrazaft Family Logan
Dr-Link &irFlug =treme G Dhw/L-GEBO

Double-click on Network. DiakUp Adapter

Realtek RTLE139 Family PCI Fast Ethermet NIC _ILI
1| | »

Eemowe | Fioperies |

Click Add.

Primany Metwark, Logon:
Microsoft Family Logan j

Filz and Frint Sharing... |

Dezcription

OF. | Cancel |

Select Network Component Type |

LClick the type of network, component you want to ingtall
‘Ll Client

Highlight Client. ' &y s rier Add.__ ]|

i Pratocal Cancel |
Click Add. Service

&, client enables vour computer ko connect to ather
corpliters.




TCP/IP Printing for Windows 98SE/Me (continued)

Select Network Client E

i i Click the Metwork Client that pou want to inzstall, then click OF. [f pou have
At this WlndOV.V, an installation disk for this device, click Have Disk.
click Have Disk.

Manufacturers: Metwork Clients:

B Banyan DOS Avfindows 3.1 client

Have Dizk. .. |]

1. Insert the DP-G321

CD-ROM into your [ ok | Cancs
CD-ROM drive. |
Select the letter
representing the
CD-ROM drive on Open I B
your computer from File name: Ealders: 4
N Ipr.inf Al
the pull-down menu. | [lrin gt _ 5 o |
2. Double-click on MNetwark... |
the folder lpr.
3. Highlight Ipr.inf. =
4. Click OK. Pl
1 |[®- 7]

Install From Dizk E3

Click OK to accept the Inzert the manutacturer's installation dizk into
location of the file. @ the drive selected, and then click OF.

Cancel

Copy manufacturer's files fron:

G:A\LFR j Browsze. |




TCP/IP Printing for Windows 98SE/Me (continued)

Select Metwork Client

E Click the Metwork Client that you want ta inztall, then click Ok, [f you have
—4 an installation dizk for this device, click Have Disk.

Models:
E R me”g

Have Disk... |
(]4 I Cancel |
Hetwork EE |

Configuration | Identificatinnl Access Ennlrnll

Click OK.

You should now be
back to the Network
Properties Page.
Highlight LPR for
TCP/IP Printing.

The following network, components are installed:

B Client for Microzoft Mebwaorks -
l LPR for TCPAP Prirting

83 0-Link AirPlus #treme G DwL-GES0

J8 Dial-Up &dapter -
1| | v

EEmasyE Froperiies

Click Properties. Prirnary Metwork Logar:
bicrozoft Family Logon j

File and Frint Sharing...

Diezcription

OF. Cancel




TCP/IP Printing for Windows 98SE/Me (continued)

LPR for TCP/IF Printing Properties
Parts | S ettings |
—Port List
Click Add Port.
Acld Part... [Delete Part
ak I Cancel |
.
Type in the IP Address of
IP Al :
the DP-G321. Make sure IW

the Port Name is accu-
rate (The Port Name at Port Mame :
right is just an example.) [Fs-t18688-Ut

CIle OK Cancel |

LPR for TCP/IP Prnnting Properties %]

Farts | Settingsl

—Port List

The Port name and IP
Address will be displayed.
(The Port Name at right is
just an example.)

Acled Port... Celete Port

Click OK.

Cancel

g




TCPI/IP Printing for Windows 98SE/Me (continued)

Hetwork EEd |

Configuration | |dentification I Arccess Eu:untru:ull

The following netwark, components are installed:

Client for Microsoft Metwaorks

LPR for TCPAP Printing j

Microzoft Family Logon

O-Link AirPlus =treme G DwL-GER0
Dial-Up Adapter

-
4| | v

HEmayE |

Eroperties |

Prirnary Metwork, Logaon:

icrozoft Family Logon j

File: and Print Sharing... |

[rescription

Click OK.

k. Cancel

Windows will ask for BTt E 1
arestart.

‘fou musk restart your computer before the new settings will take effect,

Do you wank ko restart your computer now?

Click Yes.

Yes Mo




TCPI/IP Printing for Windows 98SE/Me continued)

Once your computer has rebooted, click on i Add Prinker
Start > Settings > Printers > Add Printer. _> E:Ea

This wizaned il help you 10 Install your painter quickly and

To begn instaling you prres, cick Nex.

When the Add Printer Wizard
screen appears, click Next.

Select Network Printer.

How 1= thes prnter attached b your computer?

11t b ditectly aitached to your compulter, ciick Local
P@ier. 1F i i altached lo anolher computer. cick Network
P-'!I'

 Locd piinter
£ Metwork printer

Click Next.

Add Printer Wizaed

Typa the network path of the quews name of pou piinter.
¥ you dont know ds name, cick Browise bo view avalabis
. . . nestvnrk prinlars.

Type in the path if you know it,
or click Browse.

Metwork path or queus nama:

Do you pent from MS-D05-based progeams ?
 Yer
& Ho

<Back | Mew» Cancel




TCP/IP Printing for Windows 98SE/Me (continued)

At the next screen, browse for the printer
port. Highlight the port as shown. (The Port
Name in this window is just an example.)

Click OK.

If the network path is not specified, type in
the IP Address of the DP-G321 and the Port
Name. (The Port Name shown at right is
just an example.)

Select Yes or No, to answer the question:
Do you print from MS-DOS based pro-
grams?

Click Next.

Highlight the printer, as shown. If your desired
printer is not on the list, click Have Disk and
insert the printer driver disk that came with
your printer to install the printer drivers.

Click Next.

Click Next.

Browse for Printer HE

Select the network printer that you want to add.
Mote: Printers are usually attached to computers.

=28 Metwork Meighborhood
EM)_) Erttire Network,
SR % Pt S ervers - 1CP/F LAR
== 192 158.0.10

' [t i l Cancel |

——

Add Printer Wizard

Type the netwark path of the queue name of your printer.
IF you don't know s name, click Biowse ta view avalable
network prnters

Network path or queue name:

\AT52 166.0. 10%ps- 1166881

Blowse,

Do you piint from MS-DOS-based programs
—
=  Yes

& hlo

¢Back [| Nt > l Cancel |

Add Printer Wizard

s, Dok the manacturer ad modelof your pinte. I your vt cene wih an
[ instalalion disk, click Have Disk. If your printer s nat lsted, consult your printer
documentation for a orpatibls printer.

Manufacturers Printers:

Colorbae =] [Epson Sl Pro ESCP 2 =
Compag | [Epson Stis ProxL ESCiP 2

Dataproducts Epson Stylus Pra XL+ ESC/P 2

Dicarix Epson T-750

Digits!

LEPSOM Stlus COLOR 740

it |

<gack! Hext> ' |

Add Printer Wizard

‘ou can type a name for this printer, or you can use
the name supplied below. When pou are ready, click.
Finish ta install the printar and add it to the Printers

o folder

Brinter name:

“Your Windows-based programs will use this printer as the
default printer.

<Baok (| Fish |} cancel




TCPIIP Printing for Windows 98SE/Me (continued)

Select Yes to print
a test page.

Click Finish.

Go to Start >
Settings > Printers
Check to see that your
printer is installed.

Aftal your prinkes i instalad. Windows can print a est
page 1o pou can canlim that e prints: sl up peopesl

Swfiouid pou Bke to pord @ bast page®

& e esommenied
L

il-ldr.ﬁ Fl'lhhi

Cancel |

B3 Printers = =] B3

J File Edit “iew Go Favorites Help |

- +.@‘§£‘”

Elark ’ Ernrard Up Cut Copy Paste

J Address I Printers j

Printers

€]

Add Printer

COLOR 740

Add Printer

The Add
Printer wizard
wallks you
step-by-step
through
installing a
printer. Just
follaw the
instructions
on =each
sCreen.




Unix/Linux Printing

Please refer to the PS Admin Manual on the CD included with your purchase for
information on setting up the Print Server in Unix/Linux.



Setting up Apple Talk or LPR
Printing in Mac OS X

Note: Mac OS printing with this print server is sup-
ported by PostScript printers only!

With Mac OSX you can use AppleTalk or LPR printers using IP protocols for printing
through Print Servers. Follow the instructions below for setting up the Print Server.
After attaching the Print Server to your network using the directions provided in the
Quick Installation Guide, change the IP address of your Macintosh to access the
Print Server’s web configuration.

Internet & Metwork

Open your System
Preferences @ p—
window and Click F h’@
Network. Internet Metwork QuickTime Sharing
8o Network =]
Location: [ Automatic [ #)
At the Configure e
Show: | Built-in Ethernet a
pull-down menu,
select Manually. Manually
OWENE / Using DHCP |
Using BootP
L lame Servers (Optional)
IP Address: 4.2.2.2
(Provided by DHCP Server)
Subnet Mask:
Router Search Domains (Optional)
DHCP Client ID:

(Optional)

Example: apple.com, earthlink.net
Ethernet Address: 00:05:02:33:a3:84

@ Click the lock to prevent further changes. F\.ﬂﬂlfsf Now



Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

The default IP
address of the Print
Server is
192.168.0.10.
Manually change
your |P Address to
102.168.0.x, where
X is any number
between 1 and 254
(except 10 which is
the IP Address of
the Print Server.)
The IP Addresses
and Subnet Mask
shown here are
examples only.

Select the AppleTalk

tab in this window
and check Make
AppleTalk Active.

8eco Network [<=]
w = NQ
Show All : Displays Sound Metwork Startup Disk
Location: | Automatic K2
Show: | PCI Ethernet Slot C1 K2}
= e v,

— TTTTE—
| Manually using DHCP Router '

Configure « Using DHCP

Using BootP
m=vame Servers (Optional)

IP Address: 192.168.10.7
(Provided by DHCP Server}

Subnet Mask: 255.255.255.0

Router: 192.168.10.1 Search Domains (Optional)

DHCP Client ID:
(Optianal)

Example: apple.com, earthlink.net
Ethernet Address: 00:50:ba:b0:00:05

@ Click the lock to prevent fu Ié‘i?‘?ﬁﬁQ_o_ " A/ 2% - .Ap_q{_y_.'\low
80C Network (o]
Location: | Automatic T'?“‘

Show: | Built-in Ethernet F";’i

{Tcenp

[ Make AppleTalk Active )

Computer Name: D link’s Computer
{Can be changed in Sharing Preferences)

AppleTalk Zone: e

Configure: = Automatically i

AppleTalk zones are unavailable until AppleTalk is on. To start AppleTalk, click Save.
Then choose a zone.

f‘ Apply Now

@ Click the lock to prevent further changes.



Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

To print, open a document
and select File > Print

from the menu.

Select Edit Printer
List from the Printer

dialog box.

Click Add Printer.

@ TextEdit

Edit Format Window Help

T .
Open... go ‘Pliled
Open Recent >

Close W

Save 85

Save As... {385

Save All

Revert to Saved

Page Setup... <3P

Printer: { ¥ No Printer Selected '

Saved Settings: Edit Printer List... % |

f Copies & Pages FR,
Copies: EColiated
Pages: @ All
O From: 1 to: 1
® ( Previewj ( C‘nncei) ‘j:'iﬁ’f: R
. e [&] 0 Printer List .
“® Thame & Kind T etatis

“etere ™ ((Add Prmier 1)

64



Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

Select the printing
protocol preferred,
AppleTalk or LPR

Printers using IP.
In this example,

AppleTalk has been
selected.

AppleTalk protocol:
After selecting
AppleTalk the Port
Name of the Print
Server will be dis-
played. The Port
Name shown here is
an example only.

Click on the Port to
which the PostScript
printer is connected.

v Apple?alk

LPR Printers using IP

- Elps-116688-U1

o Name |

USB

R

BFa
v

Directory Services

Printer Model: Auto Select...

00

Laserwriter

t‘ﬂ

r Cancel W

Printer List

o
®

I Name

& Kind

Status

PS - 116688-U1

Laserwriter

" Delete \ [Add Printer...1

Then select the printer model from the dialog box displayed here.
Click Add Printer and the Printer Port configuration is complete.
Select the Printer Port just configured in the Print window.

Click Print to print your document.

B




Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

LPR Printers using IP
protocol:

When you select LPR
Printers using IP Proto-
col, this window will ap-

"LPR Printers using [P

LPR Printer's Address: | 192.168.0.10
Internet address or DMS name

pear.
[ Use Default Queue on Server

Type the IP Address of the Queue Name: | PS-116688 - U1 |

Print Server into the LPR —_— = :

Printer’s Address field. Printer Model: [ConerE. .

" cancel ® m—a

In the Queue Name field, type in the Port Name of the PostScript printer that is
connected to the Print Server. The Port Name illustrated here is only an example.
Select the printer model from the dialog box.

In the Queue Name field, type in the Port Name of the PostScript printer that is
connected to the Print Server. The Port Name illustrated here is only an example.
Select the printer model from the dialog box.

Click Add and the process is complete.

Close all Print Center windows, select the Printer Port that was just selected.

Click Print to print the document.Click Add and the process is complete.



Setting up Apple Talk Printing
in Mac OS 9

Note: Mac OS printing with this print server sup-
ports PostScript printers only!

The AppleTalk network protocol is used with computers using the MacOS operating
system. It can be used for network communications over standard Ethernet or Fast
Ethernet using the EtherTalk transport, or over a proprietary low-speed LocalTalk
transport.

Your Print Server can be used for network printing to PostScript printers. You can
print from any MacOS computer connected to your Ethernet network, either directly
using an EtherTalk connection, or indirectly through a LocalTalk-to-EtherTalk router.

NOTE: The Chooser name of a printer connected to one of the Print Server’s ports
is the same as its Port Name. If you are using AppleTalk printing, you will need to
make sure that every Port Name is unique among all of the network printers in your
AppleTalk zone. The Port Names shown in this manual are examples only.

Setting up the Print Server for AppleTalk Printing

To set up your Print Server so that it can be used for AppleTalk printing:

m Make sure the AppleTalk protocol is enabled in your Macintosh.

m Change the IP address on one of the computers on your network to
192.168.0.x, where x is any number between 11-254.

m Type 192.168.0.10 into the address field of your Web browser. 192.168.0.10
is the default IP Address of the DP-G321.

m Select the Network tab and scroll to the bottom to the AppleTalk protocol
section.

m If your AppleTalk network is divided into AppleTalk zones, you will have to
specify which zone the Print Server should be in. You should locate the Print
Server in the same zone as most of the users who will be using it. If your
network is not divided into zones, the AppleTalk Zone field should contain a

k)

single asterisk “*”.



Printing from Mac OS Client Workstations

The exact procedure for selecting a PostScript printer connected to your Print
Server may vary slightly, depending on what printer driver version you are using.
The procedure described below assumes you are using the LaserWriter 8.

To choose a printer connected to your Print Server as your Mac OS
workstation’s default printer,

Open the Chooser by selecting Chooser from the Apple menu.

Select the LaserWriter 8 icon on the left. Make sure that AppleTalk is set
to Active.

A list of all networked PostScript printers will be displayed:

88— thtser==—————0~=-H

Select a PostScript Printer:

@ PS-116688-U1

re Color 2% Fro

00/LS | Laserwriter

Double-click the name of
the Printer Port you wish
to use. The Printer Ports
shown are examples only. | |w=er

%

2Sh,

>
=]
o

o

&

]

ter

E

Frewiew™

@ Active
) Inactive 7.6.2

AppleTalk




Printing from Mac OS Client Workstations

(continued)

If you have not previously
set this printer as the
default, your computer
will prompt you for a
PostScript Printer
Description file. Choose
Select PPD.

Select the appropriate
printer description file for
your printer.

Click Open.

(If your printer is not listed,
click Generic to use a
generic printer
description.)

Current Printer Description File (PPD) Selected:
= “Generic®
Auto Setup | ' Select PPD... I'
[ Printer Info ] [ Configure ]
Open
@ Printer Descriptions i] E@
Name | Date Moditied |2
T3 HF LagerJet 4L 547701 =
EP HF LaserJet 4MP 547701
EJ HP LaserJet 4MP ¢ 300 dpi) 547401
[ HP LaserJet 451 (300 dpi) 547701
0 THP LaserJet 45i v2011.110 5/7/01 | |
3 HP LaserJat 4 543/01 %
Use the Generic PostScript™ Printer Description file:
(eaneet ([ _oper

If you wish to access this setting in the future, you can use the Setup button in the

Chooser window.

The selected printer will become your computer’s default printer. You may need to
choose Page Setup in any applications you have open.




Networking Basics

Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using
Microsoft Windows XP.

Note: Please refer to websites such as http.//www.homenethelp.com
and http.//www.microsoft.com/windows2000 for information about networking
computers using Windows 2000, ME or 98SE.

Go to Start>Control Panel>Network Connections.

Metwork Setup Wizard

Welcome to the Network Setup
% Wizard

Thiz wizard will help pau zet up this computer b in on wor
nebwork. with a netwark you can;

Share an [nternet connection

Set up Internet Connection Firewall
Share filez and folderz

Share a pnnter

-
-
-
-

To continue, click Mest.

Mest > |[ Cancel

When this screen appears, click Next.



Networking Basics (continued)

Please follow all
the instructions in
this window:

In this window,
select the

best description of
your computer.

If your computer
connects to the
Internet through a
gateway/router,
select the second
option as shown.

Click Next.

Network Setup Wizard

Before you continue...

Befare pou continue, review the shecklist bor creating a netwark,

Then, complete the following steps:

+ |nstall the network. cards, modems, and cables.

+ Turn on all computers, printers, and external modems.
+ Connect to the Intermet.

‘wihien pou click Mest, the wizard will zearch for & shared Internet connection on your netwark,

< Back II Mest » ]’ Cancel
|

Metwork Setup Wizard

Select a connection method.

Select the statement that best dezcribes this computer:

() Thiz computer connects directly to the Intemet. The other computers on my network connect
to the Intemet through this computer.

Wiew an example.

(%) This camputer connects ta the Intemet through anather computer an my netwark, or thraugh
a residential gateway.
Wiew an example.

i

Learn more about horne or small office network, confiqurations.

[—
[ < Back II Mest » " Cancel




Networking Basics (continued)

Enter a Computer
description and a
Computer name
(optional).

Network Setup Wizard
Give thizs computer a description and name.

’ LComputer description: | Mary's Computer |

Examples; Family Foom Computer or Monica's Computer

' Computer name: | Office |

Click Next.

Enter a Workgroup
name. All computers
on your network
should have the
same Workgroup
name.

Click Next.

. workagroup name: Accounting

Examples: FaMILY or MONICA

The current computer hame i Office

Learn more about computer names and descriptions.

< Back Mext = Cancel

Network Setup Wizard

Mame your network.

M ame wour network by specifying a workgroup name below. All computers on your network
should hawe the same workgroup hame.

Examples: HOME or OFFICE

[ < Back I'“ Mest » ]‘" Cancel




Networking Basics (continued)

Please wait while
the Network
Setup Wizard
applies the
changes.

When the changes
are complete,
click Next.

Please wait while
the Network
Setup Wizard
configures the
computer.

This may take a
few minutes.

Network Setup Wizard

Ready to apply network settings__.

The wizard will apply the following zettings. This process map take a few minutes to complete
and cannot be interupted,

Settings:
Mebwork zettings: ~
Cormputer description: Mary's Computer
Computer name: Office
Wwiorkgroup name: Accounting
The Shared Documents folder and any printers connected to this computer have been
shared.
M

To apply theze zettings, click Mext.

< Back I” Mest > J'[ Cancel

Network Setup Wizard

Please wait__.

Please wait while the wizard configures thiz computer for home or zmall office networking. This
process may take a few minutes.




Networking Basics (continued)

In this window, select
the best option. In this
example, Create a
Network Setup Disk
has been selected.
You will run this disk on
each of the computers
on your network.

Click Next.

Insert a disk into the
Floppy Disk Drive, in
this case drive A.

Format the disk if you
wish, and click Next.

Metwork Setup Wizard

You're almost done...

=\ You need to wn the Metwork Setup Wizard once on each of the computers on pour
\y retwork. To mn the wizard on computers that are not running Windows ¥P, you can uze
the Windows =P CD or a Metwork Setup Disk.

what do you want to do’?

() Usze the Metwork Setup Disk | abeady have
() Uze my Windaws =P CD

() Just fimish the wizard; | don't need ta run the wizard on other computers

Network Setup Wizard

Insert the disk you want to use.

Inzert a dizk the inta the follawing disk drive, and then click Mexst.
3% Floppy [4:]

If pou want to format the disk, click Format Disk.

< Back ]L Mest > J




Networking Basics (continued)

Please wait while the Network Setup Wizard copies the files.
Copying... E]

i L

Please wait while the wizard copies files. ..

[ ) Cancel |

Please read the information under Here’s how in the screen below. After you
complete the Network Setup Wizard you will use the Network Setup Disk to run
the Network Setup Wizard once on each of the computers on your network. To
continue, click Next.

Metwork Setup Wizard

To run the wizard with the Network Setup Disk__. %

i Complete the wizard and restart this computer. Then, uze the Network Setup Disk to run
thie Metwork, Setup ‘Wizard once on each of the other computers o paur networl:,

Here's how:
1. Inzert the Mebwaork Setup Dizk into the nest computer you want to network,

2. Open My Computer and then open the Metwark Setup Disk.
3. Double-click "netsetup.''

¢ Back IE_HEHD Jl




Networking Basics (continued)

Metwork Setup Wizard

Completing the Network Setup
Wizard

You have successfully et up thiz computer for home or zmall
office nebworking.

Far help with harme ar zmall affice networking, see the
fallowing topics in Help and Support Center;

+ zing the Shared Documents folder
+ Sharnng hles and folders

To see other computers on your nebwark, click Start, and then
click My Metwark Places.

To cloge thiz wizard, click Finizh.

<Back [ Finish |

The new settings will take effect when you restart the computer. Click Yes to re-
start the computer.

System Settings Change X

P ‘ou musk restart wour compuker before the new settings will take effect,

Do wou wank bo restark your compuker now?

You have completed configuring this computer. Next, you will need to run the Net-
work Setup Disk on all the other computers on your network. After running the
Network Setup Disk on all your computers, your new wireless network will be
ready to use.



Networking Basics (continued)
How to assign a Name to your computer

To name your computer, please follow these directions in Windows XP:

= Click Start (in the lower left corner of the screen).

= Right-click My Computer.

m Select Properties.

m Select the Computer
Name tab in the System
Properties window.

= You may enter a
Computer Description
(optional).

= To rename the computer
and join a domain, Click
Change.

n Zommand Prompk

i
@ Windows Movie Maker
“ M3l Explorer

® Windows Media Plawer
t@ Tour Windows XP

All Programs b

w—— |
Open
g M Explore

Search...

Manage
B«

Map Metwork Drive. ..
;"_# Pr Disconnect Metwork Drive. ..

Show on Desktop

@ﬂ He  Rename

System Properties

General

Windows uzes the following information to identify your computer
on the network.

Computer descriphion:

Full computer name:  Office

Wworkgroup:

T o uze the Metwork [dentification wizard to join a Metwork 1D
domain and create a local user account, click Network =

0.

To rename this computer or join a domain, click Change.

tic Updates I Remate |
Hardware | Advanced |

For example: "Kitchen Computer' or "Mary's
Computer".

Accourting




Networking Basics (continued)
How to assign a Name to your Computer

m In this window, enter the
Computer name.

= Select Workgroup and
enter the name of the
Workgroup.

= All computers on your
network must have the same
Workgroup name.

= Click OK.

Computer Hame Changes

Y'ou can change the name and the membership of thiz
computer. Changes may affect access to network resources.

LCaomputer hame:
Office |

Full computer narme;
Office

More...

tember of
() Domair:

(%) workgroup:
| Accounting |

I OK l Cancel

How to find your IP Address in Windows XP

The computers connected to your network must be in the same IP address
range. To verify the IP address, please do the following:

= Right-click on the
Local Area Con-
nection icon in
the task bar.

Disable

Repair

m Click Status.

Yiew dvailable Wireless Metwarks

Open Metwork Connections




Networking Basics (continued)
How to find your IP Address in Windows XP

This window will appear. Wireless Network Connection 7 Status |E|E|
- Click the Internet Protocol [TCPAIF)
Support tab. Address Type: Agzigned by DHCP
[ IP &ddress: 192.168.0.114 ]
Subret Mask: 205, 255.255.0
Default Gateway: 192.168.0.1

Details...

= Click Close.

l LCloze |

Assigning a Static IP Address in Windows XP/2000

Note: DHCP-capable routers will automatically assign IP addresses to the com-
puters on the network, using DHCP (Dynamic Host Configuration Protocol)
technology. If you are using a DHCP-capable router you will not need to assign

static IP addresses.
If you are not using a DHCP capable router, or you need to assign a static IP
address, please follow these instructions:

|@ Tour Windows XP

Files and Settings Transfer

H-' Control Panel

= Go to Start. .,{é Printers and Faxes

WWizard
1 !‘) Help and Suppork:
Paint 7y
. .ﬂ r) Search
. Double-click
Control Panel. Rl Praiiianis D =7 Run...

ﬁ| Log OFf |‘6| Turn CFF Computer




Networking Basics (continued)
Assigning a Static IP Address in Windows XP/2000

= Double-click
Network
Connections.

= Right-click Local Area
Connections.

= Double-click
Properties.

80

¥ Control Panel

File Edit WView Favorites  Tools  Help

Q Back \‘)

Address [} Contral Panel

Control Panel o
‘L) add or Remove Programs
@ Switch tn Category View 3 Administrative Taols

See Also

S WWindows Update
g) Help and Support

&= Game Controllers
’Internet Dptions

Phane and Modem Cptions
FyPower Qptions
“saPrinters and Faxes
9 Regional and Language Options
(= Scanners and Cameras
A5cheduled Tasks
Sounds and Audio Devices

& Taskbar and Start Menu
i User Accounts

" Network Connections

File Edt View Favorites Tools Advanced Help

Qoack - ) (T D ssach [ Folders

Address | @ Metwark Connections

A Name

Network Tasks LAN or High-Speed Internat

Create anew
connection

2 Set up a home or small
office network

& Disable this netwark
device

&, Repair this connection

@ Rename this cannection

) View status of this
connection

Change settings of this
connection

Disable
Status
Repair

Bridge Connections

Create Shartcut
Delete

Rename

Other Places

3 control Panel i

Details

4 view or change settings for this connection, such as adapter, protocol, or modem configur



Networking Basics (continued)
Assigning a Static IP Address in Windows XP/2000

Click Internet Protocol
(TCP/IP).

Click Properties.

Select Use the
following IP address in
the Internet Protocol
(TCP/IP)Properties
window.

Input your IP address and
subnet mask. (The IP
addresses on your network
must be within the same
range. For example, if one
computer has an IP
address of 192.168.0.2, the
other computers should
have IP addresses that are
sequential, like 192.168.0.3
and 192.168.0.4. The
subnet mask must be the
same for all the computers
on the network.)

Input your DNS server
addresses. (Note: If you
are entering a DNS server,

-L Local Area Connection 7 Properties

General | Bevanced |

RIX

Conhect using:

I H@  D-Link DWL-AB50

This connection uzes the following iterns:

g Client for Microzoft Metworks
.@ File and Printer Sharing for Microsoft Metworks

oS5 Packet Scheduler
K =it Protocal (TCPAFP) )

Install...

Description

Transmission Contral Protocol/Internet Protocol. The default
wide area network, protocol that provides communication
across diverse interconnected networks.

[ Show icon in notification area when connected

o)

Cancel

Internet Protocol (TCP/IP) Properties

| General |

ou can get IP settings assigned automatically if your network, supports
thiz capability. Othenwize, you need ta ask your netwark. administrator for
the apprapriate P settings.

() Obtain an IP address automatically
{#) Use the following IF address:

IP address: 192 .168. 0 . 52
Subnet mask; | 285285 . 285 . 0

Deraut gatevay: Tioe. tee. 0.1

ddress autol

(&) Use the follawing DMS server addiesses:
Preferred DNS server

yOU mUSt enter the IP Alemate DNS zerver: |:|

address of the Default |

Gateway.) |
ll (K Jl[ Cancel ]

The DNS server information will be supplied
by your ISP (Internet Service Provider.)

= Click OK.




Technical Specifications

Printer Connection
Printer Port: USB 2.0 or Parallel

Bidirectional Communication: Hewlett-Packard PJL (Printer Job Language) standard
for bidirectional communication.

Network Connection

Network Standards: IEEE 802.3 10Base-T Ethernet, IEEE 802.11g Wireless Standard
Network Data Transfer Rate: 10/100 Mbps (megabits per second), up to 54Mbps
Network Connector: CAT5 cable

Network Protocols

Ethernet Frame Types: 802.2, 802.3, Ethernet Il, SNAP (auto-switching)

Transport Protocols: TCP/IP, NetBEUI, AppleTalk/EtherTalk, LPR,SMB

TCP/IP Protocols Supported: BOOTP, SNMP, Telnet, TFTP, FTP, LPD, RARP, DHCP, IPP

Management and Diagnostics
Standard: SNMP

MiBs: MIB-II (RFC 1213)

Diagnostic LED Indicators: Power, LAN, USB, WLAN

Environmental and Physical

Power Supply: External power supply providing 5V, 2.5ADC
Dimensions: 3.54" x 3.19" x 1.57" (90mm x 81mm x 40mm)
Weight: approx. 5.19 0z. (1479)

Operating Temperature: 32 to122°F (0 to 50°C)

Storage Temperature: -13to 131°F (-25 to 55°C)
Humidity: 5% to 95% non-condensing

Emissions: FCC Class B, CE Class B, VCCI Class B



Frequently Asked Questions

Q: | am unable to establish a connection between my print server and my D-Link router.

A: Verify that your connection between both units is good. Check for valid link lights on your
router and your print server. You may be using a bad or incorrect cable.

Q: | am unable to make a wireless connection between my wireless print server and my D-
Link router.

A: Most wireless connection problems are either caused by distance between your print
server and your router or your router may be using WEP encryption. For trouble shooting
please remove any form of wireless encryption and move the products closer together.

Q: My printer will not print when connected to my print server.

A: Verify that your printer and your print server are compatible. Log into the Web based
management and use the printing test function under Tools. If your printer fails to print the test
page then your printer is not compatible with this print server.

Q: My test page prints fine from the Web based management but prints out unreadable text
when | try a Windows based test page.

A: lllegible text is caused by incorrect or corrupted drivers 80% of the time. Please visit your
printer manufactures web page and download the latest print drivers for your OS.

Q: | have another manufacturer’s wireless router and can not get the print server to connect.

A: You will need to first change the IP address of your print server to match that IP address
scheme of your wireless router.

Ex: D-Link uses “192.168.0.x” for its default IP scheme. Where “x” is a number between 2 to
254,

Run PS Admin from a Windows based PC. This will allow you to connect to the print server
and change its default IP from 192.168.0.10 to something that matches your wireless
network. For testing connections make sure that you disable any WEP encryption on the
wireless router.

Q: | plug in my USB printer but the USB light does not turn on.

A: Please be aware that your USB light will only illuminate when traffic is being passed across
the USB port. If you would like to make sure that your printer is being detected by the print
server, log into the Web based management and check the printer status.



Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and within
Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our website,
or by phone.

Tech Support for customers within the United States:

D-Link Technical Support over the Telephone:
(877)453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:

D-Link Technical Support over the Telephone:
(800)361-5265
Monday to Friday 8:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:
« Serial number of the unit
» Model number or product name

« Software type and version number




Warranty

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

B D-Link or its authorized reseller or distributor and

B Products purchased and delivered within the fifty states of the United States, the District of
Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or
FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described below will
be free from material defects in workmanship and materials from the date of original retail purchase of the
product, for the period set forth below applicable to the product type (“Warranty Period”), except as otherwise
stated herein.

1-Year Limited Warranty for the Product(s) is defined as follows:

B Hardware (excluding power supplies and fans)One (1) Year
M Power Supplies and Fans One (1) Year
B Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period at no
charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will be
rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be new or
have an identical make, model or part. D-Link may in its sole discretion replace the defective Hardware (or any
part thereof) with any reconditioned product that D-Link reasonably determines is substantially equivalent (or
superior) in all material respects to the defective Hardware. Repaired or replacement Hardware will be
warranted for the remainder of the original Warranty Period from the date of original retail purchase. If a
material defect is incapable of correction, or if D-Link determines in its sole discretion that it is not practical to
repair or replace the defective Hardware, the price paid by the original purchaser for the defective Hardware
will be refunded by D-Link upon return to D-Link of the defective Hardware. All Hardware (or part thereof) that
is replaced by D-Link, or for which the purchase price is refunded, shall become the property of D-Link upon
replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”) will
substantially conform to D-Link’s then current functional specifications for the Software, as set forth in the
applicable documentation, from the date of original retail purchase of the Software for a period of ninety (90)
days (“Warranty Period”), provided that the Software is properly installed on approved hardware and
operated as contemplated in its documentation. D-Link further warrants that, during the Warranty Period, the
magnetic media on which D-Link delivers the Software will be free of physical defects. D-Link’s sole obligation
shall be to replace the non-conforming Software (or defective media) with software that substantially
conforms to D-Link’s functional specifications for the Software or to refund at D-Link’s sole discretion. Except
as otherwise agreed by D-Link in writing, the replacement Software is provided only to the original licensee,
and is subject to the terms and conditions of the license granted by D-Link for the Software. Software will be
warranted for the remainder of the original Warranty Period from the date or original retail purchase. If a
material non-conformance is incapable of correction, or if D-Link determines in its sole discretion that it is not
practical to replace the non-conforming Software, the price paid by the original licensee for the non-
conforming Software will be refunded by D-Link; provided that the non-conforming Software (and all copies
thereof) is first returned to D-Link. The license granted respecting any Software for which a refund is given
automatically terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software of
D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, or the
liquidators expressly disclaim their warranty obligation pertaining to the product and in that case, the product
is being sold “As-Is” without any warranty whatsoever including, without limitation, the Limited Warranty as
described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its return
policy. In case the return policy period has expired and the product is within warranty, the customer shall
submit a claim to D-Link as outlined below:

The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm the
same.



[l The original product owner must obtain a Return Material Authorization (“‘RMA”) number from the
Authorized D-Link Service Office and, if requested, provide written proof of purchase of the
product (such as a copy of the dated purchase invoice for the product) before the warranty service
is provided.

B After an RMA number is issued, the defective product must be packaged securely in the original or
other suitable shipping package to ensure that it will not be damaged in transit, and the RMA number
must be prominently marked on the outside of the package. Do not include any manuals or
accessories in the shipping package. D-Link will only replace the defective portion of the Product
and will not ship back any accessories.

M The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD”) is allowed. Products sent COD will either be rejected by D-Link or become the property of
D-Link. Products shall be fully insured by the customer and shipped to D-Link Systems, Inc.,
17595 Mt. Herrmann, Fountain Valley, CA 92708-4160. D-Link will not be held responsible for
any packages that are lost in transit to D-Link. The repaired or replaced packages will be shipped
to the customer via UPS Ground or any common carrier selected by D-Link, with shipping charges
prepaid. Expedited shipping is available if shipping charges are prepaid by the customer and upon
request.

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the foregoing
requirements, or for which an RMA number is not visible from the outside of the package. The product owner
agrees to pay D-Link’s reasonable handling and return shipping charges for any product that is not packaged
and shipped in accordance with the foregoing requirements, or that is determined by D-Link not to be defective
or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced or
removed; Initial installation, installation and removal of the product for repair, and shipping costs; Operational
adjustments covered in the operating manual for the product, and normal maintenance; Damage that occurs in
shipment, due to act of God, failures due to power surge, and cosmetic damage; Any hardware, software,
firmware or other products or services provided by anyone other than D-Link; Products that have been
purchased from inventory clearance or liquidation sales or other sales in which D-Link, the sellers, or the
liquidators expressly disclaim their warranty obligation pertaining to the product. Repair by anyone other than
D-Link or an Authorized D-Link Service Office will void this Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FORAPARTICULAR PURPOSE
AND NON-INFRINGEMENT. IFANY IMPLIED WARRANTY CANNOT BE DISCLAIMED INANY TERRITORY WHERE
APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO NINETY (90)
DAYS. EXCEPTAS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE
RISKASC;I'O 'E:HE QUALITY, SELECTIONAND PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF
THEPRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER
ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FORANY
LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER DIRECT,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES FORLOSS OF
GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION,
FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK’S PRODUCT IS CONNECTED
WITH, LOSS OF INFORMATION OR DATACONTAINED IN, STORED ON, OR INTEGRATED WITHANY PRODUCT
RETURNED TO D-LINKFOR WARRANTY SERVICE) RESULTING FROM THE USE OF THE PRODUCT, RELATING
TOWARRANTY SERVICE, ORARISING OUT OF ANY BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK
HAS BEENADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THE SOLE REMEDY FORABREACH OF THE
FOREGOING LIMITED WARRANTY IS REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-
CONFORMING PRODUCT. THE MAXIMUM LIABILITY OF D-LINK UNDER THIS WARRANTY ISLIMITED TO THE
PURCHASE PRICE OF THE PRODUCT COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN
WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR
REMEDIES, EXPRESS, IMPLIED OR STATUTORY.



Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some states
do not allow exclusion or limitation of incidental or consequential damages, or limitations on how long an implied
warranty lasts, so the foregoing limitations and exclusions may not apply. This limited warranty provides
specific legal rights and the product owner may also have other rights which vary from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product may be
reproduced in any form or by any means or used to make any derivative such as translation, transformation,
or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as stipulated by the United
States Copyright Act of 1976. Contents are subject to change without prior notice. Copyright® 2002 by D-Link
Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communication. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

|
[ | Increase the separation between the equipment and receiver.
|

Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

| Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance
could void the user’s authority to operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1)This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

IMPORTANT NOTE:
FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of about 8 inches (20cm) between the
radiator and your body.

This transmitter must not be co-located or operated in conjunction with any other antenna or transmiter.



Registration

{ Register your D-Link product online at http://support.dlink.com/register/

(10/07/04)



Appendix:

DP-G321 Printer Compatibility List For Windows

The Canon Printer
Canon BJC-55, 85
Canon S100SP
Canon S200SP
Canon S300
Canon S330
Canon S400SP
Canon S450
Canon S520
Canon S600
Canon S750
Canon S4500
Canon S6300
Canon S9000

The Epson Printer

Epson Stylus Color 900

Epson Stylus Color 1160

Epson Stylus Color 2200

Epson Stylus Photo 720

Epson Stylus Photo 810, 820, 830, 890
Epson Stylus Photo 900

Epson Stylus Photo 1280, 1290
Epson Stylus C41UX, C405, C42UX
Epson Stylus C60, C61, C62

Epson Stylus C80, C82

The Lexmark Printer
Lexmark Z13
Lexmark Z25
Lexmark Z33
Lexmark Z35
Lexmark Z43
Lexmark Z45
Lexmark Z53

The HP Printer

HP DeskJet 640C, 656C
HP DeskJet 845C

HP DeskJet 920C

HP DeskJet 948C

HP DeskJet 960C

HP DeskJet 990Cxi, 995C
HP DeskJet 1125C, 1180C
HP DeskJet 1220C

HP DeskJet 3320

HP DeskJet 3420, 3425
HP Color Inkjet CP1700
HP LaserJet 1200

HP LaserJet 2200, 2200d




Appendix: DP-G321 Printer Compatibility List for Windows (continued)

The Lexmark Printer
Lexmark 4039 10R
Lexmark 5700
Lexmark Optra Color 45
Lexmark Optra C710
Lexmark Optra E, E+, E310
Lexmark Optra K1220
Lexmark Optra M410, M412
Lexmark Optra N
Lexmark Optra R+
Lexmark Optra S1250, S1855
Lexmark Optra SC-1275
Lexmark Optra SE-3455
Lexmark Optra T614
Lexmark Optra W810

Lexmark Z53

Other printers from the brands listed above may also be supported.
For an updated compatibility list please visit: http://www.support.dlink.com
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